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WHERE ARE THE LESSON FILES?
Purchase of this Classroom in a Book in any format gives you access to the lesson fi les you’ll 
need to complete the exercises in the book.

1 Go to peachpit.com/PhotoshopCIB2025.

2 Sign in or create a new account.

3 Click Submit.

4 Answer the questions as proof of purchase.

5 Th e lesson fi les can be accessed through the Registered Products tab on your Account page.

6  Click the Access Bonus Content link below the title of your product to proceed to the 
download page. Click the lesson fi le links to download them to your computer.

• Note: If you encounter problems registering your product or accessing the lesson fi les or web 
edition, go to peachpit.com/support for assistance.

• Note: If you purchased a digital product directly from peachpit.com, your product will already be 
registered. Look for the Access Bonus Content link on the Registered Products tab in your account.

▶ Warning: For access to the lesson fi les, please register and download your fi les by 
December 31, 2029.

http://peachpit.com/PhotoshopCIB2025
http://peachpit.com/support
http://peachpit.com
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EXPLORING GENERATIVE AI

Lesson overview
In this lesson, you’ll learn how to do the following: 

• Create and enhance images using generative AI features.

• Refine the results of generative AI to get the image you want.

• Use different types of generative AI features in Photoshop.

• Understand how Adobe Firefly generative AI handles issues related 
to generative AI, such as rights and credits.

This lesson will take about 30 minutes to complete. To get the lesson files 
used in this chapter, download them from the web page for this book at 
peachpit.com/PhotoshopCIB2025. For more information, see “Accessing 
the lesson files and Web Edition” in the Getting Started  section at the 
beginning of this book.

As you work on this lesson, you’ll preserve the start files. If you need 
to restore the start files, download them from your Account page.

15

http://peachpit.com/PhotoshopCIB2025
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Adobe Firefl y generative AI is built into Photoshop 
so that you can quickly explore visual ideas and 
create photorealistic or illustrative images simply by 
describing what you want.

PROJECT: BREAKFAST PROMOTIONPROJECT: BREAKFAST PROMOTION



390 LESSON 15 Exploring Generative AI

About Adobe Firefly generative AI
The term artificial intelligence, or AI, isn’t new; you’ve probably been hearing it for 
years, and it’s been around for decades. For most of that time, AI has been about 
calculating results or analyses that seem unusually advanced. More recently, AI has 
been extended to include visual recognition such as being able to identify faces and 
read text in images.

Generative AI is much newer, and it’s called “generative” because it isn’t just about 
calculating or recognizing — it can create entirely new content. You saw this in 
Lesson 1 when you used Generative Fill to extend a photo into an empty area, con-
vincingly, in seconds. Traditionally, you’d do this kind of image extension by hand 
using a cloning tool to copy image content to the empty area, but there was always 
the risk of areas being obvious repetitions of something else in the image, and it 
took a significant amount of time. 

The ability of generative AI to seemingly invent completely new photorealistic 
images or write new text or music seems miraculous or magical, but in reality, 
generative AI only knows what to create based on its model of the problem and how 
well that model has been trained. Generative AI models are trained using very large 
sets of examples. Generative AI in Photoshop is trained on hundreds of millions of 
images. Because the quality of generative AI depends on its training, generative AI 
is constantly improving as the models are trained on more examples.

Generative AI is used not only in Photoshop but throughout many Adobe applica-
tions and services. For example, anyone can try generative AI in Adobe Express, a 
set of easy-to-use creative tools that work in a mobile app or web browser. Adobe 
gave their overall generative AI technology its own name, Adobe Firefly, and added 
Firefly capabilities into many of their applications including Photoshop.

There are some guidelines and restrictions for using Firefly generative AI; see  
www.adobe.com/legal/licenses-terms/adobe-gen-ai-user-guidelines.html.

How does Photoshop use generative AI?
Adobe Firefly generative AI is so useful that it appears in different forms throughout 
Photoshop so that it can help solve a range of challenges. You’ll find generative AI in 
places including:

Contextual Task Bar. After you create a selection marquee using any tool or 
method, the Contextual Task Bar offers a button such as Generative Fill or Generate 
Image; you learned this in Lesson 2. When the Contextual Task Bar is hidden or 
when the document context (such as the layer type selected in the Layers panel) 

http://www.adobe.com/legal/licenses-terms/adobe-gen-ai-user-guidelines.html
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doesn’t display generative AI options, generative AI features are still available in 
other ways.

Edit menu. On the Edit menu, you’ll find the Generative Fill, Generate Image, and 
(in some versions) Generative Workspace commands. You’ll learn about all three of 
those later in this lesson.

Options bar. Some tools contain generative AI options. The Remove tool you tried 
in Lesson 2 has a Mode menu that includes generative AI options that can improve 
the results. In Lesson 5, you learned that the Crop tool has a Generative Expand 
option for filling empty areas created by cropping and straightening.

Many of these features didn’t exist a few years ago, and people are finding new uses 
for generative AI all the time. Don’t be surprised if there are even more generative 
AI features in Photoshop by the time you read this.

In earlier lessons, you used generative AI to repair or extend images. That use of 
generative AI is as a production tool to improve images you created or already have. 
Now it’s time to try using generative AI the other way: to create whole new images!

Getting started
You’ll use generative AI to complete a document that helps promote an earlier 
start time for breakfast service at a restaurant. The document needs to be easy to 
adapt for the different ways the restaurant wants to promote the service, so it’s been 
designed as a tall, narrow document so that it can easily be exported for posting on 
vertical format social media feeds, and it also matches a common size for an ad in a 
print publication.

1 Start Photoshop, and then simultaneously hold down Ctrl+Alt+Shift (Windows) 
or Command+Option+Shift (macOS) to restore the default preferences. (See 
“Restoring default preferences” on page 5.)

2 When prompted, click Yes to delete the Adobe Photoshop Settings file.

3 Choose File > Browse In Bridge to open Adobe Bridge.

4 In Bridge, click Lessons in the Favorites panel. Double-click the Lesson15 folder 
in the Content panel. 

5 Compare the files 15_Start.psd and 15_End.psd.

6 In Bridge, double-click the 15_Start.psd file to open it in Photoshop. If the 
Embedded Profile Mismatch dialog box appears, click OK.

7 Save the document as 15_Working.psd in the Lesson15 folder. If the Photoshop 
Format Options dialog box appears, click OK.

• Note: If Bridge 
isn’t installed, the 
File > Browse In Bridge 
command in Photoshop 
will start the Creative 
Cloud desktop app, 
which will download 
and install Bridge. After 
installation completes, 
you can start Bridge. 
For more information, 
see page 3.

• Note: If Photoshop 
displays a dialog box 
telling you about the 
difference between 
 saving to Cloud 
Documents and 
On Your Computer, click 
Save On Your Computer. 
You can also select 
Don’t Show Again, 
but that setting will 
deselect after you reset 
Photoshop preferences.



392 LESSON 15 Exploring Generative AI

Generating a complete image
In earlier lessons, you used generative AI to enhance existing images. Another 
popular use of generative AI is to create entirely new images. Th e 15_Start.psd 
document needs an appealing image of a breakfast.

You do have to think about how appropriate generative AI is for the project you’re 
working on. Th is project promotes a general breakfast service and not a specifi c 
named dish, so a generative AI image may be acceptable; but always check with the 
client. If the promotion was about a specifi c item on the menu, it would be much 
better to commission a photograph of what that menu item actually looks like.

Th e lesson fi le has two layers. Th e bottom layer, Gradient Fill, is a radial  gradient 
that goes from transparent in the center to black at the edge. If you want to 
inspect how it’s set up, in the Layers panel select the Gradient Fill layer, and then 

• Note: The examples 
of generative AI images 
in this lesson may diff er 
from the results you 
get, in part because, 
over time, Adobe Firefl y 
generative AI is likely to 
be updated and trained 
with more images to 
improve the results.
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in the Tools panel select the Gradient tool so that the Properties panel displays 
Gradient Adjustment options. Th e gradient is transparent in the center so that after 
you generate an image and move it to the bottom of the layer stack, you’ll be able to 
see the image through the gradient.

Th e top layer, Breakfast Ad Text, was created in Photoshop as a separate document 
and saved as a Photoshop PDF to maintain its vector outlines. It was then brought 
into this lesson fi le using the File > Place Embedded command, which adds it to the 
Layers panel as an embedded Smart Object.

If the document contained a pixel layer and it was selected, the Contextual Task Bar 
might off er a Generate Image button. Neither of the existing layers is a pixel layer 
(one is an embedded Smart Object layer and the other is a gradient fi ll layer), but 
that’s not a problem; you can still use generative AI from the Edit menu.

1 Choose Edit > Generate Image.

2 In the Generate Image dialog box, click in the “Describe…” prompt box, type 
healthy breakfast to describe the image for it to generate, and then click 
Generate. If a message appears asking you to read and agree to the Generative 
AI User Guidelines, click Agree when you’re ready.

▶ Tip: Because the 
vector text outlines in 
the Breakfast Ad Text 
layer are preserved in 
Photoshop PDF format, 
the text edges remain 
smooth if you scale up 
that Smart Object layer.

▶ Tip: The prompt 
in step 2 uses just two 
words, but it’s common 
for a prompt to use 
more words to get the 
image you want.
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Generating images may take some time. When it fi nishes, you’ll see that:

• On the canvas, the empty selection is replaced with new content.

• In the Layers panel, a new Generative Layer was created, and the name of the 
layer is the prompt you entered.

• In the Properties panel, as long as a generative layer is selected, a Variations 
section off ers alternatives you can click to try. Th e selected variation is the 
one you see on the canvas.

3 In the Layers panel, 
drag the Healthy 
Breakfast layer to the 
bottom of the layer 
stack so that you 
can see the design 
working as intended, 
showing the text and 
radial gradient in 
front of the image.

• Note: If you don’t 
see the Variations 
section, it may be out 
of view, especially on 
a smaller display. Try 
scrolling the Properties 
panel to bring the 
Variations panel up and 
into view.
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4 In the Variations section of the Properties panel, click the other variations in 
turn, and leave selected the variation you think is the best.

5 Save the document.

Refi ning a generative layer
It’s common for the fi rst results of a prompt to be too far from the image you actu-
ally want. Photoshop off ers ways to make the results closer to what you want.

1 In the Variations section of the Properties panel, 
hover over the fi rst variation and click the 
ellipsis (…) menu. You don’t have to click any of 
the options, but note what they are:

• Generate Similar creates another set of 
variations for the same prompt.

• Remove Background attempts to isolate the subject and erase the back ground. 
However, manually selecting and removing the background might work better.

• Good, Poor, and Report don’t change the current variation but are a way of 
providing feedback to Adobe about the quality of the results of generative AI.

▶ Tip: Variations 
are saved with the 
document, so if you 
think the document 
fi le size is too large, 
delete any variations 
you are sure you don’t 
want to keep.
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Another way to change the results is to change the prompt.

2 In the Properties panel, click in the Prompt 
box, enter a variation on “healthy breakfast” 
by adding descriptive words, click Generate, 
and select the variation you like the most. We 
entered healthy breakfast with pancakes 
and blueberries.

So far the variations are photorealistic. Next 
you’ll choose a more illustrative style that you 
can customize.

3 Click the second icon below the Prompt box 
to open style options, select Art, and select 
a specifi c look from the Eff ects category. We 
clicked All, and then selected Art Deco.

4 Click Generate and select the variation that works best with the design.

▶ Tip: The Enter 
or Return key is a 
shortcut for clicking 
the Generate button.
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5 Click the fi rst icon below the Prompt box to open Reference Image options. 
Select one of the images (we selected the fi rst one), click Generate, and select 
the variation you like the most. Th ese results were infl uenced by the style of the 
reference image you selected.

How is Reference Image diff erent than the Eff ects? Selecting a reference image is a 
way for you to infl uence variations using any image. Th e images in the Gallery are 
simply examples, but a great use of Reference Image is for generating art based on 
your personal style. To do this, open Reference Image options, click the Replace 
Image button, and select an image that represents your style. Of course, you can also 
use Reference Image to generate art based on a style you want to emulate, such as a 
client’s style.

Take a look at the icons for Reference Image and Style Eff ects and remember them, 
because they appear in other places in Photoshop where you can use generative AI. 
For example, those options are also available on the Contextual Task Bar for genera-
tive fi ll and in the Generative Workspace dialog box (see the sidebar “Save time with 
Generative Workspace” on page 399).



398 LESSON 15 Exploring Generative AI

6 Feel free to continue to explore 
Firefl y generative AI. 

For 15_End.psd, we went with one 
of the photographic variations. 
Don’t expect to match our results 
exactly because the Firefl y model 
and training may change over time. 
Just create and select a variation 
that you think works the best for 
the promotional image.

7 When you’re done, save and close 
the document.

Th e document is now ready to save 
or export copies for various media 
using workfl ows you’ve learned in 
earlier lessons, such as exporting 
for the web, printing on your own 
printer, or exporting for a print 
 service provider.

About generative credits
Generative AI requires signifi cant computing power. Sometimes it can all be 
done on your computer. Other times, the fastest way to generate the results is for 
Photoshop to send the prompt and image to Adobe Firefl y on a Creative Cloud 
server where the results are generated using a much more powerful computer, and 
then on your computer, Photoshop receives the results and integrates them with 
your Photoshop document.

It takes a lot of cloud computing power to run generative AI, so Adobe came up 
with a system to manage server usage called Generative Credits. Creative Cloud 
members receive a certain number of Generative Credits every month. Th e number 
of credits you get depends on the Creative Cloud plan used by you or your school 
or organization. If you run out of Generative Credits before the end of a month, you 
can continue to use Generative Fill, but it may run more slowly because your jobs 
will have a lower priority. If you need to restore performance priority, it’s possible 
to purchase more credits. For more information, including how to see the number 
of generative credits you have in the current month, see helpx.adobe.com/fi refl y/
using/generative-credits-faq.html.

Adobe continues to work out how to best provide generative AI services, so 
Generative Credits policies may change or improve over time. 

• Note: At the time 
this lesson is being 
written, the maximum 
pixel dimensions 
of a generative AI 
image in Photoshop 
is 2000 × 2000 pixels. 
If you use generative 
AI on larger areas, the 
2000 × 2000 pixel result 
will be scaled up.

http://helpx.adobe.com/firefly/using/generative-credits-faq.html
http://helpx.adobe.com/firefly/using/generative-credits-faq.html
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 Save time with Generative Workspace
Choose Edit > Generative Workspace to open a dialog box that off ers a more effi  cient, streamlined 
way to create the images you want. 

Check your work.
Generative Workspace 
remembers your prompts 
and results on a timeline, 
so if you want to better 
understand how you created 
a certain set of images, you 
can roll back the timeline to 
take a closer look at what 
you entered and how you 
refi ned it. 

Generate in parallel.
You can quickly generate 
 diff erent sets of variations in 
parallel. Instead of waiting 
for the results of a prompt 
before trying another 
prompt, you can apply mul-
tiple prompts, and each set 
of variations appears in the 
timeline when they’re ready.

Generate specifi c varia-
tions in a single prompt.
If you want to see slight 
variations on a prompt, you 
can type variables within  brackets, separated by commas. For example, you could enter “breakfast 
[sausage, vegetarian, oatmeal,  pancakes]” and Firefl y will generate four breakfasts modifi ed by each of 
the variables.

Easily open variations as documents or add to open documents. If you hover the pointer over a 
variation, a check box appears. Click the check box to select that variation. When at least one check 
box is selected, a Contextual Task Bar appears. Click Open to open the variation as a new Photoshop 
document, or click Add To to add the variation to an open Photoshop document as a layer.

Edit the timeline. Other buttons on the Contextual Task Bar, or that appear on a variation when you 
hover over it, off er other options such as liking, downloading, or deleting an image. A fi lter icon at the 
top lets you constrain the list to certain criteria; for example, you can fi lter the timeline to show you 
only images you liked.
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Popular questions about generative AI
Generative AI is unlike most other software features because it raises many ques-
tions across a number of areas that aren’t technical. This is largely because genera-
tive AI is not a simple program or algorithm. The fact that generative AI is trained 
on millions of images causes people to ask questions such as:

• Did the creators of the images in the training set give permission to use their 
images for generative AI training?

• Are the creators of the images in the training set compensated for the use of 
their images?

• Can generative AI images be used in commercial jobs?

• Is there a way to tell if generative AI was used to falsify part or all of an image?

Adobe Firefly generative AI and Photoshop address those questions as explained 
below so that you can create with confidence.

How rights are cleared for the training images
Generative imagery is created by training software models using large numbers of 
images. Some AI services may train using found images without securing appropri-
ate usage rights. Rights issues may lead to legal liability, so some companies and 
organizations may avoid using work created by services that can’t provide informa-
tion on training image rights. Adobe Firefly generative AI is designed to be “com-
mercial safe” in part because it’s trained using images where usage rights are known, 
such as images from the Adobe Stock collection and images in the public domain. 
(Note: In the United States, the term public domain has a specific legal definition 
involving the intentional release or normal expiration of copyright and is not the 
same as a copyrighted image being publicly viewable online.) For more information, 
see helpx.adobe.com/firefly/faq.html#training-data.

Adobe does not train on any Creative Cloud subscriber’s personal content.

At the enterprise level, Adobe offers intellectual property indemnity for Adobe 
Firefly. If you or an enterprise client are interested in more details about Firefly 
indemnity, do a web search for the document “Firefly Legal FAQs – Enterprise 
Customers” and download the one with the most recent date.

http://helpx.adobe.com/firefly/faq.html#training-data
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Compensating contributors to the training set
Adobe Stock is one of the sources used to train Firefly, and Adobe Stock images 
come from voluntary contributors. Submitting images to Adobe Stock requires 
agreeing to terms that give Adobe permission to create and train Firefly models with 
those images. In addition, an Adobe Stock bonus compensation plan provides a way 
for Adobe Stock contributors to be paid for the use of their images for generative 
AI training. For more information, see: helpx.adobe.com/stock/contributor/help/
firefly-faq-for-adobe-stock-contributors.html

Detecting the use of generative AI
Another issue is being able to determine whether an image is original or contains 
generative AI content. Adobe is part of an industry-wide effort called the Content 
Authenticity Initiative (contentauthenticity.org). This includes an effort to create an 
open, global standard for sharing image metadata (information) that can include 
creator attribution, includes generative AI transparency (letting people know that 
generative AI was used for at least part of the image), and is tamper-evident (so you 
can know if the metadata was altered).

Adobe is developing a Content Credentials feature that supports the Content 
Authenticity Initiative. For more information and links about how Content Creden-
tials work and how they relate to Photoshop, see helpx.adobe.com/creative-cloud/
help/content-credentials.html.

For example, if you use Firefly generative AI in an image and choose File > 
Export > Export As, a Content Credentials section at the bottom right corner of 
the Export As dialog box tells you that a Content Credential will automatically be 
applied and lets you preview what it will say if someone else decides to inspect 
the credential.

Exploring the possibilities
This lesson is only an introduction to the power of Firefly generative AI. As you 
learn to use it, you’ll probably think of more ways to use it to brainstorm, visualize, 
and possibly create finished art.

Remember that generative AI doesn’t have to be completely synthetic. You can com-
bine it with other images and photographs in Photoshop, and you can generate AI 
images where your own creativity still comes through. For example, you can apply a 
Reference Image of your work to a prompt, or you can generate an image and then 
stylize it yourself using Photoshop brushes as you did in Lesson 10. Have fun!

http://helpx.adobe.com/stock/contributor/help/firefly-faq-for-adobe-stock-contributors.html
http://helpx.adobe.com/stock/contributor/help/firefly-faq-for-adobe-stock-contributors.html
http://contentauthenticity.org
http://helpx.adobe.com/creative-cloud/help/content-credentials.html
http://helpx.adobe.com/creative-cloud/help/content-credentials.html
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About Neural Filters
Neural Filters are similar to generative AI but are more constrained and focused 
on specifi c tasks. To use them, choose Filter > Neural Filters. A list of fi lters appears; 
none is applied until you enable the toggle switch for a fi lter. It may be necessary to 
download some fi lters before using them. When a fi lter is enabled and selected, its 
options appear to the right of the fi lter list, and a large preview is to the left of the 
fi lter list. Some examples of Neural Filters are:

Smart Portrait can do things like change a smile or which ways eyes are looking.

Photo Restoration can quickly remove defects such as dust, creases, and scratches, 
and enhance old portraits.

Harmonization can help visually blend layers to look more consistent.

Super Zoom can apply AI upscaling to create a higher resolution enlargement from 
a low resolution source image, with better quality than traditional upsampling.

At the bottom of the Neural Filters dialog box, the Output menu lets you use the 
results in diff erent ways, such as a rendered layer, a Smart Filter, or a new document.

Neural Filters can be a lot of fun to play with, and may help you solve specifi c image 
editing challenges.

The Colorize Neural Filter is a quick way to add color to a scan of an old monochrome 
photograph.

• Note: Adobe may 
update Neural Filters 
after this book is 
published, so the fi lter 
list and options you 
see may depend on the 
version of Photoshop 
you use.

• Note: Some 
Neural Filters may be 
labeled Beta, which 
means they function 
but are still under 
development. You can 
use them, but when 
the fi nished version is 
released, those fi lters 
may produce diff erent 
results or some options 
may be diff erent.
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Review questions
1 Where in Photoshop can you find generative AI features?

2 What feature/command name creates an entirely new picture (instead of altering an 
existing picture)?

3 What are at least three ways to improve a generative AI result that isn’t quite right?

4 How can you make a generative AI result more like your own personal creative style?

5 Why are Adobe Firefly generative AI images called “commercial safe”?

Review answers
1 You can find generative AI features in the Contextual Task Bar (under certain 

conditions), on the Edit menu, and on the options bar when some tools are selected.

2 Generate Image.

3 You can select a different variation, change the prompt text, apply effects, and apply a 
reference image.

4 Apply a reference image using an image that represents your personal style.

5 Adobe Firefly images are trained on images where the rights either have been secured 
or are not an issue because the images are legally in the public domain.
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INDEX

SYMBOLS
2 Up Vertical command  373
32 Bits/Channel mode  315

A
actions

playing  350
recording  346–351
sets  346

Actions panel  346
Add Artboard button  354
Add Audio option  279
Add Layer Mask button  133
Add Media button  278
Add Noise filter  247
Adjustment Brush tool  244
adjustment layers

about  114–115
Black & White  62
Curves  126–127
Hue/Saturation  114, 218
Levels  142
to part of a layer  243

Adobe After Effects  314
Adobe Bridge

about  44
for inspecting files  40
installing  3
Load Files into Photoshop Layers 

command  231
opening files in Camera Raw  

from  296
opening files in Photoshop from  44

opening images from  296
previewing a file  140, 274

Adobe Camera Raw
about  295
adjusting white balance in  300
Before/After Views button  297, 302
cameras supported by  296
Clone tool  318
deleting documents  297
file formats for saving changes  314
filmstrip  317
as a filter  323
gradient masks  328
Heal tool  318
histogram  306
masking  297
masks panel  320
Open as Object button  311
profiles  299
Raw Details  307
Remove tool  318
saving files from  309–310
Select Background  305, 328
Select Objects  328
Select People  305, 324, 328
Select Sky  305, 328
Select Subject  305, 328
Super Resolution  307
synchronizing settings across 

images  308
version  294
workspace  297, 298

Adobe Capture  222
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Adobe Creative Cloud
installing applications  3
mobile apps  222
portfolio online  384

Adobe Creative Cloud desktop 
application  3, 7

Adobe DNG (Digital Negative) file format  
296, 314, 315, 329

Adobe Express  390
Adobe Firefly  10, 390

commercial use  400
compensation plan for contributors  401
effects  396
generative layer  394
prompt  393
reference image  397
refining  395
training  400

Adobe Fonts  4, 26, 188, 199, 202
Adobe Generator  352
Adobe Illustrator  208, 314
Adobe InDesign  191, 314
Adobe Lightroom  12
Adobe Lightroom Classic  312–313
Adobe PDF (Portable Document Format)

Photoshop PDF format  199
printing on press  378

Adobe Photoshop
installing  3
new features  2
resetting default preferences  10
starting  4, 10
work area  10–41

Adobe Photoshop Classroom in a Book 
(2025 release)

about  1
lesson files and Web Edition  5
prerequisites  2

Adobe Portfolio  384–386
Adobe Raw profile  299
Adobe RGB  369
Adobe Stock  12

designing with  120
Libraries panel import  103
licensing  120
Search Adobe Stock command  95

AI  390. See also Adobe Firefly
alpha channels  163
anchor points  209, 212
animating

Pan & Zoom effect  285
position  281
text  281–284

animation, frame  288
anti-aliasing  76
Apple iPad  67, 68
applying an edit  15
arrow keys, nudging with  75–76
artboards

about  352
adding  354
duplicating  352
exporting  360
mobile devices and  355
presets for sizes  354
resizing  357

Artboard tool  354, 357
audio, in a video timeline

adding  279
fading  280
muting  280–281

Audio track  279
Auto-Align Layers  152
automating tasks  346–352
Auto-Select option  116
AVIF file format  314, 315

B
background layer

about  90, 92
converting to a regular layer  92, 348
erasing  95

background, removing  163
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barrel distortion, correcting  147
batch processing. See actions
bitmap images

as used in Photoshop  10
vs. vector graphics  206–207

black and white, converting color images
in Camera Raw  299
in Photoshop  62

black point  303
Black & White adjustment layer  62
Blend Images Together option  141
blending modes

applying to layers  99
deciding which to use  100
definition  98
previewing  99, 100

Bloat tool in the Liquify filter  239
blog, Photoshop tips and info  7
blur

Blur Gallery  132
Field Blur  130
Iris Blur  130
Path Blur  130, 131, 133
restore noise  131
Spin Blur  130, 138
Tilt-Shift  130

Blur Effects panel  131
Blur Gallery  130–131, 132
borders, adding  95, 116
bounding box  14, 15. See also transform 

controls
Bridge. See Adobe Bridge
brightening an image  126–127, 142
bristle tips, for brushes  254
Browse In Bridge command  44
brushes

loading with color  259
presets. See brush presets
rotation angle  263
settings  255

Brushes panel  261

brush presets
exporting  262
loading  261–264
painting with  264–266

Brush Settings panel  255
Brush tool

about  32
Paint Symmetry  267

buttons, as web graphics
creating  333–352
duplicating  341

C
calibration, monitor  370
Calibration panel, in Camera Raw  305
Camera Raw. See Adobe Camera Raw
Canvas Size command  348
center, selecting from  80
central processing unit (CPU)  3
channels. See color channels
Character panel  105, 201
character styles  191
checkerboard transparency  

indicator  95
chromatic aberration  147
Clarity, in Camera Raw  317, 323
Classroom in a Book.  

See Adobe Photoshop Classroom  
in a Book (2025 release)

Clean Brush After Every Stroke  
icon  258

Clean Brush option  259
clipping, gamut  377
clipping masks

about  163, 185
creating  115, 188–190
indicator  189
shortcut  189

Clone Stamp tool  60
closing a Photoshop file  12
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Cloud Documents
about  67
opening  11, 68
saving  68

Clouds filter  103
CMYK color mode, converting to  370
CMYK color model  367, 368
collaborating

libraries and  222
sharing an image  16

color
additive  368
adjusting for printing  376
adjusting overall  51
changing foreground  31
channels. See color channels
converting to black and white  62
default text  188
fonts  201
foreground and background  31
management. See color management
mixing with the Mixer Brush  258
out-of-gamut  373
sampling  31, 255
softening edge transitions  76

Color blending mode  100, 240
Color Burn blending mode  100
color casts, removing  51
color channels  163, 296, 379–381
Color Dodge blending mode  100
color gamut. See gamut
Color Grading panel, in Camera Raw  305
color management  367–370, 369–370, 383
Color Mixer panel, in Camera Raw  305
color profile. See profiles, color
Color Range command  84, 324
color sampler  375
color samplers, in Camera Raw  297
color separations  380
Color Settings dialog box  369–370
color settings, saving and restoring  6

color space  368
combining images

using Adobe Bridge  231
by dragging layers  93–96
into an HDR merge  315
into a panorama  140–143, 315
using Place Embedded/Linked 

commands  14
with different perspectives  153–156

Commit button  86, 101
committing (applying) an edit  15
compositing. See combining images
Content Authenticity Initiative  401
Content-Aware Crop  144
Content-Aware Fill for panoramas  141
Content-Aware Move tool  60, 158
Content Credentials  401
Content panel, in Bridge  45
context menus  91, 98, 119, 190, 199
Contextual Task Bar  15, 390
Contrast slider in Camera Raw  303
Control Timeline Magnification slider  277
Copy command  93
copying

anti-aliasing edges  76
commands  83
images  119, 373
layers  93, 93–95
selected pixels  82, 83
settings in Camera Raw  308

Copy Merged command  83
corner points  209
Create Video Animation  288
Create Video Timeline  276
Creative Cloud. See Adobe Creative Cloud
Crop and Straighten Photos command  60
Crop tool  47–50, 86–87

clearing settings  50
crop shield  50
leveling  50

Cross Fade transition  285
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Curvature Pen tool  207, 208, 211
curved paths  209
Curve panel, in Camera Raw  305
Curves adjustment layer  51, 126

D
Darken blending mode  100
Darker Color blending mode  100
Decontaminate Colors option  173
defaults

in Camera Raw  327
resetting Photoshop  5, 10

Define Custom Shape command  223
Define Pattern command  179
Delete Cropped Pixels option  50
Denoise, in Camera Raw  327, 328
depth of field, extending  150
Deselect command  72
Detail panel, in Camera Raw  306
Difference blending mode  100
Difference Clouds filter  243
Direct Selection tool  209, 217
Discover panel  6
discretionary ligatures  201
distortions, correcting  153
DNG. See Adobe DNG (Digital Negative) 

file format
docking panels  30
document size, displaying  16, 118
document window

fitting image to  81
scrolling  20
status bar  18

dots per inch (dpi)  49
drag-and-drop importing  103
Drop Shadow layer style  343, 348
drop shadows  110–111, 112
duplicating

buttons  341–345
images  119, 373
layers  341

duration of video clips, changing  280

E
educators, resources for  7
Elliptical Marquee tool

centering selection  80
circular selection  74
in Tools panel  66

emoji fonts  201
Enhance command  327
Enhance Edge option  71
Exclusion blending mode  100
Expand command  73
Export As command  360, 361
exporting

Adobe Camera Raw edited version   
296, 309–315, 327

artboards  360
brushes  262
layers as separate files  361
video  286

Extras command  76
Eyedropper tool  31, 32, 255
eye icon, in the Layers panel  91

F
face adjustments

with healing tools  318
with Liquify filter  128, 234

Face-Aware Liquify filter  128
fading audio  280
Farrer, Lisa  424
Faulkner, Andrew  270
Feather command  76
feathering  76
Field Blur  130
file formats. See name of format
file size  49
fills

foreground color  117
gradient  106
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pattern  179
shape layer  207
Solid Color layer  29

filmstrip, in Camera Raw  297
filters

adding clouds with  102
Add Noise  247
Difference Clouds  243
in Camera Raw  323
Liquify  234–235
Neural Filters  402
Smart Filters. See Smart Filters
Smart Sharpen  61, 347

Find. See Search command
Find Distractions  84
Fit On Screen command  81

Hand tool shortcut  80
Flatten Image command. See flattening
flattening  52, 118, 378
Focus Area command  84
fonts

alternates  201
changing in the options bar  26
color  201
emoji  201
Font Similarity  199
formats  184
installing  4
OpenType format  201
PostScript format  201
previewing in context  187
selecting  186
special characters  200
TrueType format  184
variable  201

Font Similarity option  199
Foreground and Background colors  31, 108
forum, Photoshop community  7
four-color printing (CMYK)  368
fractions  201
frames  333
Frame tool  333

Freeform Pen tool  207
Free Transform command  232, 234

moving with  237
options bar settings  355
resizing with  101
rotating with  193

Free Transform Path command  177

G
gamut, color

clipping  377
colors outside of  373–374
defined  367

Gamut Warning  373–374
Generate Image command  391, 393
generative AI  390. See also Adobe Firefly
Generative Credits  398
Generative Expand  144, 391
Generative Fill  36–38, 57–59
Generative Fill command  391
generative layer  394
Generative Workspace  391
Generator. See Adobe Generator
GIF animation  288
GIF format  90, 288
Global Light option  110
Glyphs panel  200, 201
Go To First Frame button  279
GPU. See graphics processing unit (GPU)
Gradient Fill layer  392
gradients

editing  109
listing by name  107
masks in Camera Raw  328

Gradients panel  108
Gradient tool  108
Graham, Jay  312, 424
graphics processing unit (GPU)  3
grid

in Camera Raw  297
in Lens Correction filter  148
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guides
adding  185
ruler  338
Smart Guides  226

H
Hand tool  17, 80
Hard Light blending mode  100
Hard Mix blending mode  100
HDR, in Camera Raw

HDR editing  309, 314, 315
HDR merge  315

Healing Brush tool  60
Heal tool, in Camera Raw  297, 318
Help, Photoshop  7
hiding

layers  94
selection edges  76–77

HiDPI  49, 362
histogram

Camera Raw  297, 306
in Curves and Levels adjustment 

layers  52
History panel  243–248
Home screen  11
Horizontal Type tool  26, 105, 186
Hue blending mode  100
Hue/Saturation adjustment layers  218

I
Illustrator. See Adobe Illustrator
importing. See also Place Embedded 

command, Place Linked command
audio  279
embedded Smart Objects  351
multiple files from Bridge  231

InDesign. See Adobe InDesign
Info panel  333, 338, 374
inkjet printers  382
Inner Shadow layer style  189
installing the software  3

interface. See user interface
International Color Consortium  

(ICC)  368
iPad OS  67, 68
iPhone, designing for  354
Iris Blur  130
Isolate Layers command  99

J
JPEG file format

Camera Raw and  296, 309, 314
compared to other formats  314
Export As  360
type quality  199
web design  352

JPEG XL file format  314, 315

K
Kent, Lynette  270
keyboard shortcuts

customizing  260
duplicating  82

keyframes
animating with  281
appearance of  281
moving to the next or previous  282

Kost, Julieanne  7, 168, 190, 207, 260

L
Large Document Format  314
Lasso tools  66, 77–78
layer comps  118
layer effects

adding  110–115
updating  116

layers
about  90
adding  102–103
Background  92
blending modes  98–99
converting Background  92, 348
copying  93–95
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copying and centering  94, 97
copying and merging  83
copying and pasting  93
copying to other  93
deleting  137
duplicating  98, 132, 341
effects. See layer effects;  

See also layer styles
exporting individually  361
flattening  118, 119
generating images from  352
groups  338
hiding and showing  91, 94, 95
linking  101–103
locking  91
masks  163
merging visible  118
opacity  98
overview  90
painting  240
rearranging  96–98
renaming  93
resizing  101–103
rotating  101
saving in GIF or JPEG formats  90
showing and hiding  94
styles. See layer styles
thumbnail icons  91
transforming  101
transparency  98–99
type  105

Layers panel
filtering  99
overview  91–92

layer styles
adding to type  189
applying  106–109, 110–113
in Creative Cloud Libraries  111
Drop Shadow  110, 113, 343, 348
overview  106, 110
presets  225
Satin  113
Stroke  112, 344

Layer Via Copy command  132, 136

leading  198

learning resources for Adobe  
Photoshop  6

Learn tutorials  12

Lee, Megan  268

Lens Correction filter  147–149

lens flaws, correcting  147–149

lesson files, accessing  5

Levels adjustment layers  52–53, 142

Libraries, Creative Cloud
Adobe Stock  103
color swatches  103
images  103
layer styles  111
linked Smart Objects  222
mobile apps  222

Libraries panel  120

licensing, Adobe Stock  120

ligatures  201

Lighten blending mode  100

lightening an image  126–127, 142

Lighter Color blending mode  100

Light panel, in Camera Raw  303

Lightroom. See Adobe Lightroom  
Classic

Lightroom photos online storage  41

Linear Burn blending mode  100

Linear Dodge blending mode  100

linear gradients  102–104

Linear Light blending mode  100

Liquify, Face-Aware filter  128

Liquify filter  234–235

Load Files Into Photoshop Layers 
command  231

local adjustment  243

low resolution images, upscaling  249

luminance mask  84, 328

Luminosity blending mode  100
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M
machine learning  57, 66, 165, 202, 249, 

303, 328
macros. See actions
Magic Wand tool  66, 70–71
Magnetic Lasso tool  66, 79–80
magnification. See Zoom tool

document  18–20
Timeline panel  277

magnifying glass. See Zoom tool
mandalas, painting  267
marching ants. See selection marquee
marquee tools  66
masks  162

on adjustment layers  243
in Adobe Camera Raw  320
in Camera Raw  305
channel  163
creating  133, 163–166
luminance  84
overview  162
refining  168–173
compared to selections  162
terminology  163
vector  163

Match Font command  202
megapixels  48
merging

images into a panorama  140
images to extend depth of field  150
images with different 

perspectives  153–156
layers  118

mistakes, correcting  34–41
Mixer Brush tool

about  254
cleaning the brush  259

Mixer tab, in Camera Raw  305
mixing colors

with a photograph  261
with Mixer Brush tool  258

mobile devices
designing for, with artboards  355
using with libraries  222

monitor calibration  370
More Image Settings, in Camera  

Raw  327
motion blur effects  131
Motion panel  285
Move tool

Auto-Select option  116
moving selections  72
scissors icon  81

moving
layers. See Move tool
panels  30
selections  72–73

Multiply blending mode  100
muting audio  280–281

N
navigating

in Camera Raw  297
using the Navigator panel  20

Navigator panel  20
Neural Filters  129, 402
New Window command  373
noise reduction  327
noise reduction, in Camera Raw  328
nondestructive filters  234
notes. See also Note tool

deleting  199
Notes panel  197

Note tool  197
nudging layers  359
nudging selected pixels  75

O
Object Selection tool  73–74, 133
on-image adjustment tool. See targeted 

adjustment tool
opacity, changing  98–99
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opening images in Camera Raw  296
Open Object button in Camera  

Raw  311
OpenType font format  184, 201
OpenType SVG  201
options bar  15

reference point icon  355
setting type options in  26

organizing photos  312–313
out-of-gamut color  373–374
output options, Neural Filters  399
output resolution, determining  49
Overlay blending mode  99, 100

P
P3 color space  369
painting

layers  240
wetness options  256
with the Mixer Brush tool   

252–266
painting gallery  268
Paint Symmetry option  267
panels

adding to another group  30
defined  15
docking  30
floating  30–31
resizing  30
undocking  30

panning with the Navigator panel  20
panoramas

in Camera Raw  315
in Photoshop  140–143

Pan & Zoom option  285
Paper Color option  372
paper, simulating white  372
paper size, print  382
paragraph styles  191
paragraph type  186
Paste command  93

Paste in Place command  83
Paste Into command  83, 250
Paste Outside command  83
Paste Profile Mismatch dialog box  248
Paste Without Formatting 

command  83, 197
pasting layers  93
Patch tool  60
Path Blur  130–131, 133
paths

about  207
adding type to  191–192
closing  209
compared to shapes  215
converting to/from selection  218
drawing  208–213
drawing curved segments  209
drawing straight segments  209
editing  217
moving  217
saving  209
work path  209

Path Selection tool  217
Paths panel  210
patterns

Pattern command  179
Pattern Preview command  177
Patterns panel  225

patterns, creating  176
Pavlov, Victoria  269
PDF. See Photoshop PDF file format
Pen tool. See also paths

drawing paths  208–212
keyboard shortcut  207
overview  207–208, 209
as selection tool  208
setting options  210–211

People in Background command  84
people masks, in Camera Raw  324
Perspective Warp command  153
Photomerge  140–143
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photo restoration, manual  54–55
Photoshop PDF file format  199, 314, 381
Photoshop Raw format (not camera  

raw format)  314
pincushion distortion  147
Pin Light blending mode  100
pixel dimensions  48
pixels

compared to vector graphics  206
defined  10
path tools option  215
resolution and  48

pixels per inch  48
Placed Linked command  334
Place Embedded command  188, 351, 

352, 393
placeholders  333
PNG (Portable Network Graphics) file 

format  314, 352
Point Color tab, in Camera Raw  305
point type

defined  186
distorting  194–195

Polygonal Lasso tool  66
Polygon tool  176
portfolio. See Adobe Portfolio
position, animating in video  281
PostScript font format  201
ppi (pixels per inch)  48
preferences

Camera Raw  297
Export  361
gamut-warning color  373
History States  248
opening  22
restoring defaults  5, 10
searching  22
Units & Rulers  22, 333

Preserve Details (Enlargement)  
option  249

Preserve Numbers option  371

presets
artboard  354
brush  261–264
in Camera Raw  297, 300, 327
Curves panel  126
Gradients panel  108
overview  35–36
shapes  221
Styles panel  225

previewing
colors for printing  370
edits in dialog boxes  61
files in Adobe Bridge  45
fonts in context  187

printing
CMYK model and  368–369
on a desktop printer  382
identifying out-of-gamut color  373–374
for inkjet printers  382
preparing images for  378
for press  365–387
proofing images onscreen  370–373

printing inks, simulating onscreen  372
process colors  368
profiles, Adobe Raw  299, 316
profiles, color

CMYK  379
display (monitor)  370
ICC  368
printer  371

prompt  393
Proof Color  374
proofing images  370–373
Properties panel  15–16, 108

artboard editing  354
Curves adjustment  51
targeted adjustment tool  62
type settings  187

proxy icon  355
PSB (Large Document Format)  314
PSD (Photoshop) format  296, 314
public domain  400
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Pucker tool in the Liquify filter  239
Puppet Warp command  174

Q
Quick Mask mode  84, 163
Quick Selection tool  66, 71, 165

R
radial symmetry  267
RAM (random access memory)  3
range masks, in Camera Raw  328
raster images, overview  206
rate images, in Camera Raw  297
Raw Details, in Camera Raw  307, 327
raw profiles  305
recording actions  346–350
Rectangular Marquee tool  66, 339
red eye, correcting  124–126
Red Eye Removal, in Camera Raw  297
Red Eye tool  125–126
Redo command  34
reference image, for generative AI  397
reference point  355
Refine Edge. See Select and Mask
Refine Edge Brush tool  168
Remove tool  53–54, 60
Remove tool generative AI option  391
Remove tool, in Camera Raw  297, 318
rendering video  286
repositioning selections  74
resampling  47
Reselect command  75
Reset, in Camera Raw  327
resizing. See also scaling

from center  237
layers  101
panels  30
proportionally  82

resolution
about  48–49
Adobe Stock images  95, 120

best practices  313
bitmap images vs. vector graphics  206
Camera Raw  298, 310
Crop tool option  47
increasing  249
professional printing  378
Retina/HiDPI scale factors  362
screens of high and low  352, 362
text  203

responsive design  353
Retina resolution  49, 362
retouching a portrait, in Camera  

Raw  316
retouching/repairing

removing blemishes  53–54
with the Remove tool  53–57

Return To Adobe Photoshop 
command  132

RGB color model  367, 368
rotating

constraining  78
layers  101
paths  193
in Puppet Warp  175
selections  78
stylus  263

rounded corners, creating  178
ruler guides  185, 338
rulers  22, 186

S
sampling colors  31, 255
Satin layer style  113
Saturation blending mode  100
saturation, in Camera Raw  303
Save for Web (Legacy) command  352.  

See also Export As command
saving documents. See also exporting

as Cloud Documents  68
flattening and  118–121
as Photoshop PDF format  199, 381

Scale to Fit Media print option  382
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scaling
animating  283
using Crop tool  50
document (Image Size command)  48
using Free Transform command  

101, 355
in Lens Correction filter  148
low resolution image  249
pattern fills  180
when printing  382
proportionally  82
raster (bitmap) images vs. vector 

graphics  206
using Scale command  82
in Sky Replacement  146

Screen blending mode  100
screening, print  380
scrubbing numeric values  27
Search command  6
Search icon  11, 12, 16
searching

Adobe Stock  120
Preferences  22
within Photoshop  11

Select and Mask command  84, 163
selecting. See also selections

about  66
adding to selection  72
center point, from  80–81
by color  66
creating from a path  218
high-contrast edges  79–80
intersecting with existing  72
modifier keys  72, 75
new selection  72
non-transparent pixels  84
skin tones  324
a subject automatically  84, 165
subtracting from  72
text  116

Selection Brush tool  66, 84, 136
selection marquee  76

selections. See also selecting
in Camera Raw  328
circular  81
converting between pixels and 

paths  85, 218
copying  83
duplicating  82
elliptical  73–81
feathering  76
freehand  66, 77–78
geometric  66
hiding edges of  76
moving  72–73, 75, 81–82, 82
rotating  78–79
showing edges of  76
softening  76

selection tools  66–67
separations. See color separations
shapes

creating your own  223
defined  215
editing  223
presets  219–222

Share button  16
Share for Review command  197
sharpening

in Adobe Photoshop  61
in Camera Raw  306–307

sholby (artist)  269
shortcuts. See keyboard shortcuts
shortening video clips  280
Show/Hide Visibility column  95
side by side documents  93
sidecar XMP files  308
Single Column Marquee tool  66
Single Row Marquee tool  66
skin tones, selecting  324
Sky command  84
Sky Replacement command  146
Smart Filters  133, 155, 234–237,  

239, 251
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Smart Guides  28, 82, 223, 226, 233
Smart Objects

converting layers to  234
editing  236
embedded  351
icon badge  234
linked  222
Smart Filters and  234

Smart Sharpen filter  61, 347
smooth points  209
snapshots, in Camera Raw  297, 327
Soft Light blending mode  100
soft-proofing  370–373
Solid Color fill layer  29
sort, in Camera Raw  297
special characters  200
spell checking  190
Spin Blur  130, 138
Spot Healing Brush tool  53–54, 60
sRGB IEC61966-2.1 color space  369, 

371, 383
stacking order, changing  96–98
star, creating a  176
starting Photoshop  10
Status Bar  16, 18
Stop Recording button  350
stopwatch icon in Timeline panel  281
storage space  3
Straighten button  47, 144
strobe effect  131
Stroke layer style  112, 344
strokes  207
Structure option  158
Styles panel  225
Subject command  84
Super Resolution, in Camera Raw   

307, 327
SVG (Scalable Vector Graphics) file 

format  201
swashes  201
symmetry, painting with  267

synchronizing Camera Raw settings  308
system requirements  3

T
tablet, graphics  255
tabs, document  15
targeted adjustment tool  62
teachers, resources for  7
temperature, image color  300
text. See also type

adding  186
applying edits  187
centering  105
creating  26, 105–106
default color  188
moving  106
selecting  116, 187

Texture, in Camera Raw  317, 323, 325
thumbnail icons, layer  91
TIFF (Tagged Image File Format)

type quality  199
Tilt-Shift Blur  130
timeline, creating  276
Timeline panel  275

changing the magnification  277
returning to the first frame  279

Tint
in Black & White adjustment  

layers  62
in white balance (Camera Raw)  300

Toggle Last State command  243
Toggle Reference Point option  355
Tolerance option for Magic Wand tool  70
tone, adjusting  51–52
tools

Brush tool  32
Clone Stamp tool  60
Content-Aware Move tool  60, 158
Crop tool  47
Elliptical Marquee  250
Eyedropper  31, 255
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Tools (continued)
Healing Brush tool  60
Horizontal Type tool  26
keyboard shortcuts  207
Lasso tool  77
Magic Wand tool  70, 73
Magnetic Lasso tool  77, 79
Object Selection tool  58, 66, 73
Patch tool  60
Polygonal Lasso tool  77
Quick Selection tool  71, 165
Rectangle tool  339
Remove tool  53, 60
selection  66–67
Spot Healing Brush tool  60
using  17–23

Tools panel. See also tools
selecting and using tools from   

18–24
tool tips, displaying  18
tracing a photo  214
tracks, in a timeline  276
transform controls  78, 93, 101, 102
transforming  101. See also Free 

Transform command
Transform Selection command  74
transitions, video  285
transparency

adjusting  98–99
blending modes and  100
recognizing (checkerboard)  95

Transparency & Gamut preference  373
TrueType font format  184, 201
tutorials built into Photoshop  11
type. See also text

aligning  186
clipping mask  185, 188–190
creating  186–187
on a path  191–192
overview  184
resizing  184
setting options  186

swashes  201
tricks  190
true fractions  201
warping  194–195

typefaces. See fonts
Typekit. See Adobe Fonts
type layers

creating new  105, 190
selecting contents  190

Type tool  26–27

U
undocking panels  30
undoing steps

with commands  34–35
with the History panel  243–248

unit of measure  22
Units & Rulers command  22
Units & Rulers preferences  333
upscaling images  249
Use Global Light command  110
user interface

Adobe Camera Raw overview  298
Photoshop overview  10–12

V
Variable Fonts  201
Variations  394
vector graphics

bitmap images vs.  206
defined  10
overview  206

vector masks  163
version, Photoshop  2
Vibrance, in Camera Raw  303
video

adding audio to  279
adding pan and zoom effects  285–286
adding transitions  285–286
clip duration, changing  280
exporting  286
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groups  279
overview  274
rendering  286

video card. See graphics hardware
vignetting  147
visibility icon. See eye icon
Vivid Light blending mode  100

W
warping

images with the Liquify filter  234
perspective  153–156
Puppet Warp  174–175
type  194–201

watermark, Adobe Stock  120
Weaver, Gawain  54, 424
web assets, exporting from layers  361
web browser, using Photoshop in  68
web design

HiDPI  362
responsive  353
Retina  362
workflow  330

Web Edition  5
Webster, Kyle T.  267
wetness options, in painting  256
White Balance tool, in Camera 

Raw  300–302
white point  303
wide gamut  369

work area  10–41
workflow preferences, Adobe Camera 

Raw  297
workflows

color-managed  369–371
compositing  90
frame animation  288
prepress  378
professional photography  312–313
video  272
web design  331

work path  209
workspaces

Graphics and Web  185
Painting  255
Workspaces menu  16

Workspaces menu  16

X
XMP files  308

Y
YouTube  287

Z
Zoom option in video  285
Zoom tool. See also magnification

in Camera Raw  297
shortcuts  168
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